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Follow-up

Following today’s event, you will receive a follow up
email, which will include:

Links to the presentation slides and
recording, if applicable

>
0\
—| Information about how to request and
— .
receive CEUs

gikp

Link to our evaluation survey (GPRA)




Land Acknowledgement

We would like to take this time to acknowledge the land and pay respect to the Indigenous Nations
whose homelands were forcibly taken over and inhabited.

Past and present, we want to honor the land itself and the people who have stewarded it throughout
the generations.

This calls us to commit to forever learn how to be better stewards of these lands through action,
advocacy, support, and education.

We acknowledge the painful history of genocide and forced occupation of Native American territories,

and we respect the many diverse indigenous people connected to this land on which we gather from
time immemorial.

While injustices are still being committed against Indigenous people on Turtle Island, today we say
thank you to those that stand with Indigenous peoples and acknowledge that land reparations must be
made to allow healing for our Indigenous peoples and to mother earth, herself.

Dekibaota, Elleh Driscoll, Meskwaki and Winnebago Nations
Ttakimaweakwe, Keely Driscoll, Meskwaki and Winnebago Nations
Ki-o-kuk, Sean A. Bear, 15t Meskwaki
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As we gather in this place, we want to
acknowledge that we are occupying the
traditional territory and ancestral lands
of the Wabanaki people, who for
thousands of years have called this place
home. We acknowledge their continued
connection to this land, give thanks for
allowing us to do this good work on their
homeland, and remember their
ancestors who were here before us.

Written by

Denise Altvater, Passamaquoddy Tribe at Sipayik
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It tastes good

It's warm and cozy

Digestive reasons

Everyone else does it

So | can feel something
for once in my life




Do you
want fo go
outside?

What are
you doing?

Starting a Fight

Do you want
to call your
mommy?

How old
are you?

Who are -
you here
with?

Hey buddy!

*shokes their
hond*

Where do
you live?

Seeing Someone &
Whose Name You ‘&
Don’t Remember <\"°

Consoling

a Lost
Child
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WHEN GHILDREN
LACK NUTRITION

This is childhood malnutrition at life-size: Each of
these children is severely malnourished—and the
red circle around each photo equals the circumfer-
ence of that child’s arm. The circle is much larger if

a child is not malnourished, as the key below shows.

Despite some gains against global hunger, mal- East Ghouta Juba Chelhar

nutrition in children under age five left 22.2 percent SYRIA, 2017 SOUTH SUDAN, 2017 PAKISTAN, 2015
of them stunted (too short for their age) and 7.5 i ; ' y
nder s

percent of them wasted (too thin for their height) this out 3 W foc :

in 2017. UNICEF's Diane Holland says catching acute c 5 : g water, ar >
malnutrition early is key to bringing children back e e Ao Tha Secntay ocass (oliealel taciltles
to healthy growth. The “MUAC bracelet” (right), r arly ac has been mired in ; ates of malnutrition among
used to measure mid-upper-arm circumference, w“u o thans : ik ;",_,;‘“‘{"'."_: f‘ cere 2
helps gauge the severity of acute malnutrition so

a child can be given lifesaving treatment and care.
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\qp

:

Al
1
1
1
)
1
1
1
1
1
)
1
1
1
1
1
1
1
1
1
1
1
1
)
1
1
1
1
1
1

Dhamar Muna Garage IDP camp Moinerghona refugee camp

YEMEN, 2017 NIGERIA, 2016 BANGLADESH, 2017

“125Cm < \ J tate's chil
MODERATE ACUTE ~m.\!-u;m shme
result of the Boko
MALNUTRITION F
~ - e Civil wa J Widespread
= Myanmar
12.5¢cm Rtias nc e 20,000 childre o 5 s military
3 om their parents set fire to their village

HUNGRIEST
COUNTRIES

Food scarcity and
malnutrition span the
globe. Of the 50 coun-
tries with the highest
percentage of children
under age five suffering
from malnutrition, more
than half are in Africa.
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Why do it
differently?
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We want the audience
to understand the data we share.



A Before and After Transformation...

and some terminology

Attendee Breakfast Preferences

3D ‘////gndhnes

1
Just a pile of bacon ‘.

/

™ Eggs
Bagel ‘
‘ m Pancakes
Fruitsalad |
| W Cereal

Don't eat breakfast _“

Cereal | = Don't eat breakfast
Pancakes “ ® Fruit salad
Eges | m Bagel
0% Just a pile of bacon
legend
'\ tick marks

title

subtitle
Breakfast preferences focus on protein.
ne in ten fellow attendees do not consume

adequate energy for their first meal of the day.

Eggs

23%
21%

Just a pile of bacon

16%
14%
0%

8%

8% .
action
X color
??i numeric
ADEIS labels



Types of Data

and

Quantitative Qualitative
How many/often Why/when
(the numbers) what it means




MAKING DATA DECISIONS I
31

Asking the following questions can help you decide what data to include in your presentation versus

what might be better suited for a handout or left out altogether.

What are the conclusions that can be drawn about the data?

What's compelling about this information?

Are there trends to show?

Are there comparisons you'd like to demonstrate?

Is there anything surprising or unexpected to share?

© 2016 Info Inspired. Some Rights Reserved.




5 C’s of Data

A guide to communicating data visually so that
insights can be quickly and easily understood.

#1 - Chart Choice
#2 - Composition
#3 - Color

#4 - Context

#5 - Clutter



Chart Choice
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Datavizproject.com

< C @ datavizproject.com/# w /'. o a
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3 out of 5 people




Chart Chooser
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Sausage

Vodka

Most Popular Pasta Sauces

Marinara

VETIETE

Sausage

Mushroom

Alfredo

Alfredo Mushroom

Pie Chart VS. Bar Chart




States with bills currently active in state legislatures that mandate people use
sex-segregated facilities according to sex assigned at birth rather than gender identity

I Bill targets public schools B Bill targets general public

Maine

Alaska Vt. N.H.

Wash. Mont. N.D. Mich. NY. Conn. R.I.

Ore. Idaho Wyo. Ind. Ohio Pa. N.J.

Calif. Nev. Utah Colo. W. Va. Md. Del. DC

Ariz. N.M.

Okla. Ark. Va.

o MARCH 23

Governor signed law requiring
schools and public buildings
Hawaii Texas La. Miss. Ala. Ga. S.C. to segregate facilities according
to sex marked on birth certificates.
Fla. l

South Carolina is considering a bill preventing
transgender students from playing on athletic
teams that match their gender identity.
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Number of Maine Microbreweries and Brewpubs

by County
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Most Popular Pasta Sauces




Composition




Substance Use in Past Month Among Pregnant Women

PAST MONTH, 2015 - 2017, 15 - 44

ILLICIT DRUGS TOBACCO PRODUCTS ALCOHOL
334K
319K 14.7%
13.9% 261K
11.5%
239K 214K
10.6% 9.3%
18954/:( 187K
143K ' 8.3%
109K 6.3%
4.7%
2015 2016 2017 2015 2016 2017 2015 2016 2017
161K
78K 14191 K 7.1%
3.4% -
0 2 26K = Yo
8 ‘[IJZ(;K 8 1.2% 8 S oK
- 1K 2K 0.4%
0.0% 0.1%
Marijuana Opioids Cocaine Marijuana Opioids Cocaine Marijuana Opioids Cocaine

+ Difference between this estimate and the 2017

estimate is statistically significant at the .05 level. ﬂMHﬂ

17 Substance Abuse and Mental Health
Services Administration

Special analysis of the 2017 NSDUH Report.




More Women Using Cannabis During Pregnancy

Rates more than doubled in a four year span.

7%

5%

3%

2013 2015 2017



More Women Using

Cannabis During Pregnancy

Rates more than doubled
In a four year span.

7%

5%

3%

2013 2015 2017

Photo by Vanessa on Unsplash




SHARP2019  Substance Use

State-identified priority substance use - Cigarettes and vaping products
State of Utah 2019 Student Survey

Percentage (Notethe default axis scale forthis chart is 50%)

0
6 8
Grade .
26 27 24 03 03 02
8 8.1 66 55 16 11 09 18
10 141 130 85 33 29 16 136
12 168 163 ne 46 46 23 159
All 10 94 69 24 21 12 97

* Since not all students answer all questions, the percentage of students reporting use in the past 30 days may be greater than the percentage reporting lifetime use.
** National comparison data are available for 8th, 10th, and 12th grade only. Monitoring the Future does not survey 6th graders.

[ State 2015 [ State 2017 [ State 2019 © MTF**

2019 Prevention Needs Assessment Survey 1




because of the

nicotine.”

Stuart Hudnall, y
Assistant PL‘fncip ca

man Nnool

of middle and high

o school students
o reported vaping in

the past 30 days.




The Facts about

w N
5% 15%
6% Graders 8t Graders

Have tried vaping at least once

) 52

10t Graders 12t Graders

SOURCE: UTAH SHARP 2019
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Projected Sales 2017-2021
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Color

title

Breakfast preferences focus on protein.
\Qne in ten fellow attendees do not consume
adequate energy for their first meal of the day.

Eggs
Just a pile of bacon

Cereal 16%

14%
Don't eat breakfast Il
8%

Fruit salad 8% .
action
X color
data numeric
labels
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23%
21%



THE STATE OF TOBAGGO USE IN MAINE

Penobscot County Profile

CURRENT CIGARETTE SMOKING RATES

More than 21 in 100 adults in Penobscot County PENOBSCOT COUNTY

17in 100 adults in Maine ADULT SMOKING RATE

adults in the 21 . 20/0 (MAINE 17.3%)

3rd HIGHEST
RATE IN MAINE
If Penobscot County’s current cigarette rate among adults was
on par with the national average, 10,954 fewer adults would
smoke. This is about the population of Orono.

TOBACCO INDUSTRY INFLUENCE IN MAINE

ﬁ:

ol =~

Tobacco Companies’ Annual 458 State Spending on
Marketing Spending in Maine MILLION

Tobacco Prevention

ADULT TOBACCO USE DISPARITIES

Current smoking rates are higher among adults
with mental illness.

9 32%
People with a behavioral health condition are not only 23.3%
more likely to smoke, they also smoke more frequently.
They account for 25% of the adult population, but they

) ) Current smoking rate Current smoking rate
consume 40% of cigarettes sold in the U.S. among aduls with no among adults with

mental illness any mental iliness



Color Scheme Brainstorming




Wow!
A million dollars!
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Revenue B
than 1% of total
general
fund revenue

Marijuana Tax
Makes up less

General Fund Revenue



DELICIOUS

MILK CHOCOLATE

(43
Grams)
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COOL MINT MILK CHOCOLAYTE

100 milligrams of THC

20 Joints from the 1970s



37,767

students are struggling
with nicotine addictionin
our state right now.

This is about the
population of Cedar City.
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Exposure cases involving marijuana only
peaked in 2019

30
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2018

2019
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2020



Poisoning Calls Related to
E-Cigarettes Have Skyrocketed

3,500

E-Cigarette Device and
Liquid Nicotine
Reported Exposures

to Poison Centers




Poisoning calls related to e-cigarettes
increased 1,360% from 2014 to 2017

2014 [ 271
2015 | 460

ZGAN 1,543
2017 3.957




Annual grocery store inflation by city, 2014

In 2014, food price inflation was higher in Seattle, St. Louis, Chicago,
and Atlanta than in other metropolitan areas

Percent change

a5 Annual percent change
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Source: Calculated by ERS, USDA, using Bureau of Labor Statistics (BLS) data.
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Chart credit: USDA Economic Research Service



2014 Annual grocery store inflation by city

Food pnice inflabion was higher in Seattle, St Louis, Chicago, and Atlanta than in other metropolitan areas

St. Louis > 3%

Seattle >3%

Atlanta 210 3%
Chicago 2103%
Detroit 210 3%
Houston 2103%
Los Angeles 210 3%

New York < 2%

Anchorage “2%

Pitsburgh < 2%

Annual % Chg

W o<2% B2t 3% B>3%
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w
T
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Chart credit: Melissa Yu, BlueGranite.com, 6/3/2016



Titles

Find
the hook.
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Visualization Guide Jl

Design for lay audiences.
Statistical information can easily overwhelm. Gear all design toward lay audiences.
Remember people look for comparisons and themes. Make them easy to see!
People read left to right, top to bottom. Avoid centering.
De-clutter! Remove grid lines and tick marks.
The more “noise” . AKA extra info you can delete, the easier (o interpret.
Titles and subtitles matter.
Make sure they're concise, interesting and at top left
Spend time creating a titie that creates a "hook” and conveys the main point.
Position at the top left, so it's read first
Use color as a tool to your advantage.
Consider using an action color.
Select color palette that goes with the theme and/or appeals to your audience
Use gradients of color: lowest value/lightest color - highest value/darkest color.
Limit the use of legends. Avoid whenever possible.
Example: when creating a bar chart, place horizontal labels beside or on the bars
Select the right data visualization for the job.

There are many online resources for deciding whether a pie chan,
line graph, or bar chart, etc makes the most sense

Present in 2D.

3D charts may look more sophisticated, but experts agree they are harder to read.
Use round numbers.

Round to the nearest whole number for the quickest, easiest transfer of information.
Put it in context.

Numbers are meaningful when we understand them in relation to the total picture.

© 2020 Info laspired. Some Rights Reserved




DATA VISUALIZATION RESOURCES

Data Viz Project
www DataVizProject.com

Stephanie Evergreen
https://stephanieevergreen.com/

Alberto Cairo
http://albertocairo.com/

Alberto Cairo Youtube tutorial
hitps://wvew. youtube mm[nlax"sl?hs_tzel ADcUFruM-1BY j |ng¥ﬁEyQ{]E| z4dJ)57
Library of Missing Datasets

Google Infographics Toolbox

Excel Cheat

Tableau

The Data Innovation Project
hitps:// in ionproject.or

Making Data Talk
hitps:/iwww.

Information is Beautiful Website
hitps://informationisbeautiful.net/

® 2022 Info Inspired. Some Rights Reserved.




Digital Storytelling 101

Native Connections
Substance Abuse and Mental Health Services Administration

U.S. Department of Health and Human Services

Subsmnco Abuse :md Mental Health
Services Administration




Digital Storytelling Resources

Telling Tales: Digital Storytelling as a Tool for Qualitative
Data Interpretation and Communication

https://journals.sagepub.com/doi/full/10.11/77/16094069211022529

Data Gathering and Narrative Based Impact Assessment through
Story Telling and Story Collection

https://jliflc.com/resources/data-gathering-narrative-based-impact-assessment-story-telling-story-collection/

Digital Storytelling 101

https://www.youtube.com/watch?v=TsIr91gurY8

Practical Uses for Digital Storytelling

https://www.youtube.com/watch?v=gNAFY65LyoM




the
truthful

Data Visualization Tutorials with

Alberto Cairo

38 videos * 1,823 views * Last updated on Sep 1, 2019

= A

O Erin Malone

SUBSCRIBE

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art"
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Infogra"phic’s “Toolubox
Google

Infographics
Toolbox

Template

https://docs.google.com/drawi
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Microsoft Excel
Cheat Sheet

https://www.customguide.com
cheat-sheet/excel-cheat-sheet.pdf

Microsoft®

x 8 Excel Cheat Sheet

Intermediate Skills

Chart Elements

d.ila you want to chart, Cick the Insert tab on
the nbbon. Cick a chan type button in the Charts
group and select the chart you want to insert

Move or Resize a Ch;

M 1 Select the chant. Place

he cursor over the chart's border and, with the 4-
headed amow I showing, click and drag to move
1. Or, ciick and drag & sizing handle U to resze &

Change iha Chian Typs: Select the chart and click
e Design tab. Click the Change Chart Type
button and select a dflerent chart

Jer o Chiget With the chart you want 10 filter
selected, chck the Filter /" button next to i
Desetect the items you want to hide from the chart
view and ciick the Apply button

Positon 2 Char's Legsad: Select the charn, cick
tne Chart Elements ' button. clck the Legend

button, and select a position for ihe legend

Salect the chan
and click the Chart Elements ~ bution. Then,
usé the check boxes 1o show or hise each
clament

HOW o M hat Esmeant

Joses { Select the chan where you want
1o & o troncing. Cick the Design tab on the
robon and chek the Add Chart Element |

button. Sefect Trendline from the meny

Chant Title Eleml ents
Bon Voyage Excursions Chart
“ ~ Styles
Data |
Bar Chart
Filters

-

g Chart
‘I .
_.\ o

Titles' SALES
Leglend
Chi
1 Select the range that contains Insen 5 Soackline Sek s you want 10

summarize. Click the Insert tab and sedect the
sparkling you want 1o iInsert. In the Location Range
fiedd, enter the cell or cell range 1o place the
sparkling and cick OK.

1. Select the ced range you
, dick the Insert tab, click the

W 10 char

Combo il button, and select & combo chart type,

Click the Page Layout tab
Click the suo [N button and select a page ske

Area. Select the cell range you want
1o pont (_m\ the P.g. Layout tab, chck the Print
Areald button. snd seect Set Print Area

oot Tuie os o Headings, Cick the
Page Layout taty Cick the Print Titles |9 button
and set whch items you wish 1o prnt

.y or o Foater: Click the Insert tab and
click the u“a.r & Fooml'lu.uw Complete the
header and footer Selds

ins and Orlenta Click the Page
l..yout tab, Click the Margins £l button to select
from a st of cormmon page margns. Cick the
Orlentation [P button to choose Portrait or
Landscape cnenaton

Custom@®uide

Free Cheat Sheets
Visit ref_customa

lide.com
Uioe.com

Chart Options
Chart Types

Column: Used to compare
dfierent values vertically side-by-

" sde. Each value is represented in
the chart by a vertical bar

{ Une: Used 1o dlustrate trends
over time {days, months, years)

" Each vaiue is plotted as a pont
on the chart and values are
connected by a Ine

Pie: Useful for showing vakees as
a percentage of a whole when all
the values add up 10 100%. The
values for each item are
represented by different colors

Bar: Simdar to column charts,
except they display nformation in
honzontal bars rather than in
verical columns

Area: Similar 1o ine chans,
| except the areas beneath the
ings are filed wih codor

XY (Scatter): Used to plot
clusters of values using sngle
points. Multiple tems can be
plotted by using different colored
points or different point symbols.

|| Stock: Effective for reportng the
fluctuation of stock prices, such

" as the high, low, and closing
points for a cenain day

Surface: Useful for findng
| optimum combnatons between
" two sets of data. Colors and
pattems indicate values that are
N the same range.

Additional Chart Elements

Data Labels: Display vakes from e cels
of the worksheet on the plot area of the
chant

Data Table: A table acded next 1o the
chart that shows the worksheet data the
chart is ilustrating

Error Bars: Help you quickly identty
Standard deviations and eror marging

Trendline: Idantifies the trend of the
current data, not actual values, Can also
entfy foracasts for future cata

Click the togic links for free lessons!
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Making Data Talk:
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